
Basics tab

General Options
Quick Sets
Copies
About
Page Preview Image

Orientation Options
Portrait
Landscape
Rotated



Custom paper size

Name
Save/Delete/Rename
Width
Height
Use Millimeters/Inches



Effects tab

General Options
Quick Sets
Page Preview Image

ZoomSmart Options
Print Document On
Scale to Fit
% of Normal Size

Watermarks Options
Watermarks
First Page Only
Edit
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Watermark details

Current Watermarks
Watermark Message
Page Preview Image

Message Angle
Diagonal
Horizontal
Angle

Font Attributes
Name
Color
Shading
Size
Style



Accessing the NT Forms tab

The NT Forms tab is available in Windows NT only.

To access the NT Forms tab

1 From the Start menu, select Settings, and then select Printers. 

2 Right-click the printer and select Properties from the menu that appears. The NT Forms tab appears on the right side of the 
properties screen.



Available trays 

Select the tray that you wish to configure. 



Size 

Choose the paper size or form that is loaded into the selected tray.



Type 

Select the paper type that matches the tray configuration. (The tray must be configured for paper type at the printer.)



Clear All 

Clears the paper size and type assignments for all trays.



Copies

Enter the number of copies you want to print (1-999). The copies setting in your application will usually override the copies 
setting in the driver.



Portrait

Select to print a page or envelope that is taller than it is wide when you view the text right-side up. Feed the paper as usual; the 
image will be rotated on the page if necessary.



Landscape

Select to print a page or envelope that is wider than it is tall when you view the text right-side up. Feed the paper as usual; the 
image will be rotated on the page if necessary.



Rotated

Select to rotate the document image on the paper 180 degrees. If the return address on an envelope is smudged, try this setting 
and feed the envelope so the return address area is fed first into the printer.



About

Click About to display printer driver version information.



Use different paper for first page

Click Use different paper for first page to specify paper settings for the first page that are different from the settings for the 
second and following pages of your print job; clear if you want to use the same paper settings for all pages of your print job. The 
paper size for all pages of the print job must be the same.



Size

Select the paper size for your document from this list, which includes saved custom paper sizes. The paper size for all pages of 
a print job must be the same. The application settings override the settings in the driver.



Type

Select the kind of paper or media you want to use. If the printer has been set up correctly, it will automatically locate the tray with 
the correct type of paper. To configure your paper trays, see the printer user guide.



Custom

Click Custom to create and modify custom paper size information.



Name

Enter the name for your custom paper size. After you have entered the name, width and height for your custom paper size, click 
Save to save your changes. Once saved, select OK. Your custom paper sizes will now be listed in the Size is: drop-down list on 
the Paper tab.



Height

Enter the height for the currently selected custom paper size. If you enter a size that is too small or too large, the driver will 
automatically adjust the size for you.



Width

Enter the width for the currently selected custom paper size. If you enter a size that is too small or too large, the driver will 
automatically adjust the size for you.



Save/Delete/Rename

Saves, deletes, or renames the selected custom paper size. Saved or renamed sizes appear in the Size is: drop-down list on the
Paper tab.



Use Millimeters/Use Inches

Click Use Millimeters/Use Inches to specify custom paper size dimensions in inches or millimeters. 



Flip Pages Up

When selected, prints the pages as though they will be bound along the top of the page as you read the text. When not selected,
pages will print as though they will be bound along the side of the page as you read the text.



Pages per Sheet

Prints up to 16 pages on one sheet of paper. 



Print Page Borders

Prints a border around each page on the sheet. You can select Print Page Borders when more than one page per sheet is 
selected.



Page Order

When Pages per Sheet is set for more than 1, this drop-down list box allows you to select the order and placement of the pages 
on the sheet.



Custom

Allows you to select your own custom print quality settings as specified in the Print Quality Details screen.



Details

Click Details to open the Print Quality Details screen.



Send TrueType as Bitmaps

Try selecting Send TrueType as Bitmaps if you are getting unexpected results with some of your text characters.



Use HP MEt

For the most reliable printing, select Use HP MEt. With this option, the printer manages memory for print jobs using Memory 
Enhancement technology (MEt).



Use More Memory

Select Use More Memory only if you are receiving printer memory error messages while printing complex pages. After printing 
your document, reset Complex Graphics to Use HP MEt. Use More Memory is not intended for general use and can slow 
printer performance.



Scale Patterns (WYSIWYG)

For the most reliable printing, check Scale Patterns. Change this option if you are getting unexpected results with printed fills 
and patterns. Clearing the Scale Patterns check box may cause differences between on-screen appearance and printed output.



Rendering Mode

Use the Rendering Mode settings to optimize graphics printing for speed and quality.

Select Automatic to allow the printer driver to estimate the optimal technique for sending graphics to the printer. This is the 
recommended and default setting.

Select Send Graphics as Vector to send graphics to the printer as a combination of HP-GL/2 and raster images. This setting 
may produce higher quality graphics output.

Select Send Graphics as Raster to send all graphics to the printer as images composed of individual dots. This setting may 
improve printing speed in some cases.

Select Send Page as Raster to send all graphics and text (TrueType fonts) to the printer as images composed of individual dots.
With this setting, the “Send TrueType as Bitmaps” option has no effect. Use Send Page as Raster if you are experiencing 
problems with overlapping text and graphics.



Automatic

Select Automatic to allow the printer driver to estimate the optimal technique for sending graphics to the printer. This is the 
recommended and default setting.



Send Graphics as Vector

Select Send Graphics as Vector to send graphics to the printer as a combination of HP-GL/2 and raster images. This setting 
may produce higher quality graphics output.



Send Graphics as Raster

Select Send Graphics as Raster to send all graphics to the printer as images composed of individual dots. This setting may 
improve printing speed in some cases.



Send Page as Raster

Select Send Page as Raster to send all graphics and text (TrueType fonts) to the printer as images composed of individual dots.
With this setting, the “Send TrueType as Bitmaps” option has no effect. Use Send Page as Raster if you are experiencing 
problems with overlapping text and graphics.



EconoMode

EconoMode (Save Toner) allows the printer to use less toner on each page. Selecting this option will extend the life of your 
toner cartridge and reduce your costs per page, but will reduce print quality.



Resolution Enhancement technology (On)

Resolution Enhancement technology (REt): On refines the print quality of characters by smoothing out jagged edges that can 
occur on the angles and curves of a printed image. Choose Off if graphics, particularly scanned images, are not printing clearly.



Resolution Enhancement technology (Off)

Resolution Enhancement technology (REt): On refines the print quality of characters by smoothing out jagged edges that can 
occur on the angles and curves of a printed image. Choose Off if graphics, particularly scanned images, are not printing clearly. 



Watermarks

Specifies the watermark text that will be printed. Click Edit to modify or create a watermark.



Edit

Click Edit to modify or create a watermark.



First Page Only

Select to print the specified watermark on the first page only. No watermarks will be printed on the second and subsequent 
pages.



Current Watermarks

Displays the list of available watermarks. Click New to create a new watermark. Click Delete to remove a selected watermark.



New

Click New to create a new watermark to appear in the list of available watermarks.



Delete

Click Delete to remove a selected watermark from the list of available watermarks.



Watermark Message

Type the watermark message that you would like printed.



Diagonal

Watermark appears in a diagonal layout on the printed page.



Horizontal

Watermark appears in a horizontal layout on the printed page



Angle Radio Button

Select this option to specify the watermark angle.



Angle Field

Indicates the current watermark angle. To change the angle, select Custom, and then type a value from 0 to 359 in the box.



Angle Control

Use this control to adjust the angle of the watermark.



Name

Select the font for the selected watermark.



Color

Select the color for the selected watermark.



Shading

Select the shading for the selected watermark.



Size

Select the font size for the selected watermark.



Style

Select the font style for the selected watermark.



% of Normal Size

Specifies the percentage of normal size by which to enlarge or reduce the document on the page. Normal size refers to the 
document page size (check your application's page size settings). If this option is disabled, click the “i” bubble to find out why.



Scale Control

Drag control to change the percentage of normal size by which to enlarge or reduce the document on the page. Normal size 
refers to the document page size (check your application's page size settings).



Print Document On

Causes the document to print on a paper size other than the one for which it is formatted. This option is useful if your document 
is formatted for a paper size that you do not have. For example, if you have a document formatted for letter-sized paper and you 
do not have that size, you can choose to print on a paper of different size.



Scale to Fit

If you don't want your document reduced or enlarged to fit on the selected paper size, clear this option.



Target Size

Select the target paper size. Only the paper sizes supported by the printer appear in this list. This option is only available when 
the Print Document On check box is selected.



Paper Handling Options

Specifies any paper handling options that are installed on the printer (for example, optional paper trays). If possible, this 
information will be detected automatically by the software and these controls will be disabled. Otherwise, you should set these 
options to match the physical setup of your printer.



Duplexing Unit

If you have a duplexing unit installed in your printer, you can print on both sides of the paper.



Envelope Feeder

The envelope feeder is an additional input source designed specifically for feeding multiple envelopes.



Ignore Application Collation

Overrides collation options selected within an application’s print options. This feature allows the printer driver to collate most 
appropriately for the job.



Mopier Enabled

The Mopier Enabled feature allows you to transmit one copy of your document to the printer and then print multiple copies. This 
speeds up the printing process when printing multiple copies and is helpful in high-traffic network environments.

The Mopier Enabled option is available only if you have a printer hard disk and/or a total of 8 MB of RAM installed in your 
printer. You must also enable [MOPY MODE] from your printer control panel. Refer to your user’s guide for more information on 
control panel settings.

You can also use the Mopier Enabled option if you are getting unexpected results when you print multiple copies using the Print 
on Both Sides option or when you use the Pages per Sheet option. If this occurs, check the Mopier Enabled option on the 
Configure tab, select Ignore Application Collation, and reprint your document. 



Optional Paper Sources

Specify any paper source option that is installed on the printer (for example, HP 500-Sheet Paper Tray).



Base Printer

Specifies your printer model. If possible, this information will be detected automatically by the software. You can choose a 
different printer, but if it is not the printer model you have, you may get unexpected results. This option is not shown for all 
printers.



Automatic Configuration

Click Update Now to query the printer for installed paper handling options and printer configuration. If the Update Now button is 
not available, select the appropriate configuration options for your printer on the Configure tab.

To enable the Update Now button, run the HP LaserJet Software Installer, select the custom installation option, and select 
bidirectional communication for the printer driver.



Quick Sets

Allows you to save the current driver settings (for example, page orientation, two-sided printing, paper source) for reuse. After 
choosing your settings, type a name for your Quick Set (for example "Quarterly Report" or "My Project Status") and click Save. 
When you save Quick Sets, all current driver settings are saved. You can also restore printer driver default settings by selecting 
Factory Defaults from the Quick Sets drop-down list. For convenience, Quick Sets can be selected and saved from most 
printer driver tabs.



Save/Rename/Delete

This button has the following options as indicated by the button label: Save enables you to save the new or changed Quick Set. 
When you save Quick Sets, all current driver settings are saved. Rename enables you to rename the selected Quick Set. To 
rename a Quick Set, highlight the name in the drop-down list and type a new name, then click Rename. Delete allows you to 
delete the selected Quick Set. For convenience, Quick Sets can be selected and saved from most printer driver tabs.



Page Preview Image

Shows how a sample document will print with the currently specified printer driver settings. The Page Preview Image changes 
as you select new settings. Click the image to change between portrait and landscape orientation. Click the paper size label to 
change between inches and millimeters.



Printer Image 

Shows a graphical representation of your printer with the currently configured options installed. If the Printer Image does not 
show all installed printer options, click the Configure tab to configure additional options. The Configure tab is only available 
when the driver is opened from the Printers folder.



Print All Text As Black

Select this option to print all text characters as black, regardless of the document’s text color settings.



Allow Manual Duplex 

Select Allow Manual Duplex to make the Print on Both Sides and Booklet Printing features available on the Finishing tab. 

Note: Using Print On Both Sides requires that the user manually reinsert the paper into the printer. This may prevent others 
from using the printer until the print job is completed.



More...

Click More... to view more configuration options.



Add…

Click to display the Add Font DIMM dialog.



Installed DIMMs

Shows currently installed Font DIMMs.



Fonts on DIMM

Shows all fonts on the selected Font DIMM and whether they are enabled or disabled.



Remove

Click to remove the selected Font DIMM and all fonts on the DIMM.



Enable/Disable Font

Click to enable or disable a selected font.



Printer Font File Location

Used with the Browse… button. Displays the location of the font information files.



Browse…

Click to navigate to the PCL 5e font information files (*.pfm) supplied by your font vendor.



Font DIMM Name

Displays the name of the Font DIMM. You can type over the name to change it. After pressing OK, the name will appear in the 
Installed DIMMs box on the Configure Font DIMMs dialog. 



Font DIMM check box

Select the Font DIMM check box when Font DIMMs are installed in the printer.



Font DIMM Configure Button

Click Configure to open the Configure Font DIMMs dialog and specify which fonts are on the DIMMs.



Font DIMMs

To use TrueType Font DIMMs, you need to physically install the Font DIMM in the printer. Once the Font DIMM is installed in the 
printer and the Font DIMM check box is selected, the software selects the fonts on the DIMM rather than sending font 
information to the printer with each job. See the printer user guide for instructions on installing Font DIMMs.



Accessing the printer driver

After installation, you can access the printer driver through Windows or from your software application. Although access to the 
printer driver from your software applications may vary, the printer driver is usually accessed from the File menu. 

Click here        to see which printer driver is set as your default.

Note
The method for accessing a printer driver is the same, no matter which printer driver you are using.

Access the printer driver

To configure the driver:

Temporarily change settings (from a software application)

From the File menu, click Print, then click Properties. (The actual steps can vary; this is the most common method.)

Change default settings

Click the Start button, point to Settings, then click Printers. Right-click the printer icon, and choose Properties (In 
Windows NT 4.0, right-click the printer icon, and choose Document Defaults).

Use the printer driver help

Each printer driver has help screens that can be activated from the Help button in the printer driver. These help screens give 
detailed information about the specific driver being used. Printer driver help is separate from the software application help.

_________________________________________________
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Creating and using Quick Sets

Quick Sets allow you to save the current driver settings (for example, page orientation, print on both sides, paper source) for 
reuse. For convenience, Quick Sets can be selected and saved from most printer driver tabs. You can also restore printer driver 
default settings by selecting Factory Defaults from the Quick Sets drop-down list.

Click here        to see which printer driver is set as your default.

Creating Quick Sets

1 Access the printer driver.

2 Select the desired print settings.

3 In the Quick Sets box, type a name for the selected settings (for example "Quarterly Report" or "My Project Status").

4 Click Save.

When you save Quick Sets, all current driver settings are saved. The printer driver now remembers these settings. 

Using Quick Sets

1 Access the printer driver.

2 Select the desired item from the Quick Sets drop-down list.

3 Click OK.

The printer is now set to print according to the settings in the Quick Sets you selected.

_________________________________________________
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Choosing print quality

The printer's default settings provide the best combination of print quality and print speed for most jobs.

To choose print quality

1 Access the printer driver and click the Finishing tab.

3 In the Print Quality section of the screen, select the preferred print quality setting.

4 Click OK.

Note

When changes have been made to the standard print quality settings, the Custom option is checked. To review the settings, 
click Details. See Choosing print quality details for more information. 



Choosing print quality details

The printer's default settings provide the best combination of print quality and print speed for most jobs. If you have special print 
quality needs, you can customize the print quality settings.

To choose print quality details

1 Access the printer driver.

2 From the Finishing tab, click Details.

3 In the Print Quality Details screen, select the preferred settings.

4 Click OK.

The printer is now set to use the print quality settings you have selected.

_________________________________________________
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Creating and using watermarks

Click here        to see which printer driver is set as your default.

To use an existing watermark

1 Access the printer driver.

2 From the Effects tab, click the Watermarks drop-down list.

3 Click the desired watermark.

4 Click First Page Only, if desired.

5 Click OK.

The printer is now set to print the watermark you have selected. To remove the watermark, click "(none)" in the Watermarks
drop-down list.

To create or edit a watermark

1 Access the printer driver.

Click here        to see which printer driver is set as your default.
2 From the Effects tab, click Edit.
3 In the Watermark Details window, select the watermark you want to edit, or click New.
4 Select the desired watermark options.
5 Click OK.
6 From the Effects tab, click First Page Only, if desired.
7 Click OK.

The printer is now set to print the watermark you have selected. To remove the watermark, click "(none)" in the 
Watermarks drop-down list.

_________________________________________________
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ZoomSmart options

ZoomSmart options allow you to scale your document to a percent of its normal size. You can also choose to print your 
document on a different size paper, with or without scaling.

Click here        to see which printer driver is set as your default.

To reduce or enlarge your document

1 Access the printer driver.

2 From the Effects tab, type the percentage by which you want to reduce or enlarge your document.

You can also use the scroll bar to adjust the reduce/enlarge percentage.

3 Click OK.

The printer is now set to scale your document using the reduce/enlarge percentage you have selected.

To fit your document to another paper size

1 Access the printer driver.

2 From the Effects tab, click Print Document On.

3 Select the target paper size you would like to print on.

4 If you want your document printed on the target paper size without scaling to fit, click Scale to Fit to deselect that option.

5 Click OK.

The printer is now set to print your document as you specified.

_________________________________________________
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Setting a custom paper size from the printer driver

Click here        to see which printer driver is set as your default.

1 Access the printer driver.

2 From the Paper tab, click Custom.

3 From the Custom Size Paper window, type the name of the custom paper.

4 Enter the custom paper’s width and height.

If you enter a size that is too small or too large, the driver will automatically adjust the size for you.

5 If necessary, click the button to change the unit of measure between millimeters and inches.

6 Click Save.

7 Click OK.

The printer is now set to print your document on the custom-size paper you selected. The name that you saved will appear 
in the Paper tab’s Size list for future use.

_________________________________________________
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Printing on different paper for the first page of a print job

Click here        to see which printer driver is set as your default.

1 Access the printer driver.

2 From the Paper tab, select the desired paper for the first page of your print job.

3 Click Use different paper for first page.

4 Click the Other Pages tab.

5 Select the desired paper type or source for the other pages of your print job.

The printer is now set to print your document on the paper you selected. 

Note
The paper size for all pages of the print job must be the same.

_________________________________________________
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Printing multiple pages on one sheet of paper

Click here        to see which printer driver is set as your default.

1 Access the printer driver.

2 Select the Finishing tab.

3 Under Document Options, select the number of pages you want to print per sheet (1, 2, 4, 6, 9, or 16).

4 Click Print Page Borders if you want to print a border around each page on the sheet.

Print Page Borders is enabled only if Pages per Sheet is more than 1.

5 If the number of pages is greater than 1, click Page Order to select the order and placement of the pages on the sheet.

6 Click OK.

The printer is now set to print the number of pages per sheet that you have selected.

_________________________________________________
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Restoring default printer driver settings

Click here        to see which printer driver is set as your default.

1 Access the printer driver.

2 In the Quick Sets box, select Factory Defaults. 

The printer driver will now restore default settings.

_________________________________________________
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OK button

Closes the dialog box and saves any changes you have made.



Cancel button

Closes the dialog box without saving any changes you have made.



Help button

Click this to display an overview of the dialog box.



Contents

Finishing tab
Effects tab
Paper tab
Basics tab
Configure tab
NT Forms tab
Common printing tasks



 Paper tab

General Options
Quick Sets
Page Preview Image
Printer Image

Paper Options
All Pages
Use different paper for first page
Size is:
Source is:
Custom
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Source

Select the tray that has the paper you want to use. You may also click on the printer image to select a source tray. If the paper 
size of the print job does not match the size of paper loaded in the tray selected, you may get unexpected results. If a paper tray 
is not listed, verify that the correct paper handling options are selected on the Configure tab. The application settings override 
the settings in the driver.



Printer Image

Click on the printer image to select a source tray. If the paper size of the print job does not match the size of paper loaded in the 
tray selected, you may get unexpected results. If a paper tray is not listed, verify that the correct paper handling options are 
selected on the Configure tab. The application settings override the settings in the driver.



Finishing tab

General Options
Quick Sets
Page Preview Image

Document Options
Print on Both Sides
Flip Pages Up
Straight Paper Path
Booklet Printing
Pages per Sheet
Print Page Borders
Page Order

Print Quality Options
Best Quality
300 dpi
Custom
EconoMode (Save Toner)
Details
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Straight Paper Path

Select this option when using Print on Both Sides and the printer is configured to print to the rear output bin.



Best Quality

Prints documents at 600 dpi. This option provides the best print quality. For best results, use graphics and fonts that are 
designed specifically for printers that print at 600 dpi resolution.



300 DPI

If you are using accessory fonts that were designed for 300 dpi printers, such as the HP LaserJet Series II and HP LaserJet III 
printers, you can print at either 600 dpi or 300 dpi resolution. For best results using 300 dpi fonts, set Print Quality to 300 dpi. 
Your printer will smooth out the 300 dpi data and give it a 600 dpi appearance.



Print quality details 

Graphics Settings
Use HP MEt
Use More Memory
Rendering Mode

Output Settings
Resolution
Resolution Enhancement technology (REt)
Scale Patterns (WYSIWYG)
Print All Text As Black

Font Settings
Send TrueType as Bitmaps



Resolution 

Resolution refers to the number of dots per inch (dpi) used to print the page. As resolution is increased, the quality (clarity and 
visual appeal) of print on the page is improved. 

The 600 dpi setting produces better print quality than 300 dpi. The 600 dpi setting provides backward compatibility with 600 dpi 
HP LaserJet printers. For best results using 600 dpi, use graphics and fonts that are designed specifically for printers that print at
600 dpi resolution. 

The 300 dpi option prints documents using 300 dpi and provides backward compatibility with 300 dpi HP LaserJet printers. 
Choose 300 dpi if your document was formatted for a previous HP LaserJet printer and you are getting unexpected results.

Changing resolution may change the formatting of your text documents.



NT Forms tab

Use the NT Forms tab to specify which paper sizes are loaded into each of the available trays. This determines the choices that 
are available in the Size list on the Paper tab. 

Note: The NT Forms tab is available in Windows NT only.

_________________________________________________
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Configure tab

The Configure tab is not available from within your applications. 

To access the Configure tab

1 From the Start menu, click Settings, and then select Printers. 

2 Right-click the printer and select Properties. The Configure tab appears.

General Options
Printer Image

 Base Printer

Paper Handling Options
Allow Manual Duplex
Optional Paper Sources

Other Options
Driver Work Space
Font DIMMs

_________________________________________________
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All Pages

Allows you to specify paper size and source for all pages or the first page of your document. To print your document using 
different paper for the first and other pages, select Use different paper for first page. The paper size for all pages of the print 
job must be the same. To print your entire document using the same paper, clear Use different paper for first page.



Print on Both Sides

Allows you to print your document on both sides of a page by manually reinserting the paper. When using this option, the print 
job will pause, and you will be prompted to reinsert the paper. This option is available when the Allow Manual Duplex check box
is selected on the Configure tab.

Note: Using Print On Both Sides may prevent others from using the printer until the paper has been reinserted into the printer 
and the print job completed.



Booklet Printing

Allows you to print a document as a booklet. In booklet printing, your pages are reordered and printed two-up on each side of a 
sheet of paper. This allows you to fold the paper in the middle, forming a booklet, and have the pages in the correct order with no
page shuffling. This option requires Print on Both Sides to be selected.

Possible Options

Original Paper size: Print on:

Letter Letter or Legal

A4 A4

Legal Legal



Driver Work Space

Specifies the amount of “work space” memory available to the printer. To determine the value that should be entered, print a 
configuration page and check the value labeled DWS or Available Memory in the memory section on the configuration page. If 
the DWS setting is not on the configuration page, the setting can be approximated by calculating 70% of the total printer 
memory. 

Tip: To print a configuration page, simultaneously press the printer’s Go and Job Cancel keys.



Font DIMM configuration

To use TrueType Font DIMMs, you need to physically install the Font DIMM(s) in the printer and configure the Font DIMM(s) 
using your HP LaserJet PCL 5e software. Once configured, the software selects the fonts on the DIMM(s) rather than sending 
font information to the printer with each print job.

Font DIMM configuration is available from the Configure tab.

To access Font DIMM configuration

1 Access the printer driver properties and select the Configure tab. (The Configure tab is not available from within your 
applications.)

2 Select the Font DIMM(s) checkbox and click Configure. The Configure Font DIMMs dialog displays.

Additional help is available from the Configure Font DIMMs dialog.

_________________________________________________
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Configuring Font DIMMs

To use TrueType Font DIMMs, you need to physically install the Font DIMM(s) in the printer and configure the Font DIMMs using 
your HP LaserJet PCL 5e software. Once configured, the software selects the fonts on the DIMM rather than sending font 
information to the printer with each print job.

To configure the Font DIMMs:

Add Font DIMMs

1 Make sure the fonts for the TrueType Font DIMM are installed in the Windows operating system.

2 Click Add… The Add Font DIMM dialog displays.

3 Click Browse… and navigate to the PCL 5e font information files (*.pfm or *.hpd) supplied by your font vendor. 

4 Click OK to accept the selected file and return to the Add Font DIMM dialog. The name of the Font DIMM displays in the 
Font DIMM Name box. (You can accept the existing Font DIMM name or type a new one.)

5 Click OK. All fonts on the DIMM are automatically enabled.

Remove Font DIMMs

Use this procedure when a Font DIMM has been physically removed from the printer, or when you no longer want the software to
select any of the fonts on the DIMM.

1 In the Installed DIMMs box, select the DIMM you want to remove.

2 Click Remove. 

Enable or Disable Fonts

Use this procedure when you want to enable or disable specific fonts on a Font DIMM.

1 In the Installed DIMMs box, select the DIMM that contains the fonts you wish to enable or disable.

2 In the Fonts on DIMM box, select the font you wish to enable or disable.

3 Click the Enable/Disable Font button. Note: The button label will read “Enable Font” or “Disable Font” depending on the 
current status of the selected font.

4 Repeat steps 1 through 3 for each font you wish to enable or disable.

5 Click OK to save the changes.



Common printing tasks

             Accessing the printer driver  
             Creating and using Quick Sets  
             Printing on both sides of a sheet  
             Using EconoMode  
             Choosing print quality  
             Choosing print quality details  
             Using REt  
             Creating and using watermarks  
             ZoomSmart options  
             Selecting paper by source  
             Setting a custom paper size from the printer driver  
             Printing on different paper for the first page of a print job  
             Printing multiple pages on one sheet of paper  
             Restoring default printer driver settings  



Printing on both sides of a sheet

This feature allows you to print your document on both sides of a page by manually reinserting the paper. When using this 
option, the print job will pause, and you will be prompted to reinsert the paper.

Click here        to see which printer driver is set as your default.

1 Access the printer driver.

2 From the Finishing tab, click Print on Both Sides. The Allow Manual Duplex check box must be selected on the 
Configure tab to make the Print on Both Sides check box visible. Click Flip Pages Up if desired.

3 Click OK.

The printer is now set to print your document on both sides of a page.

_________________________________________________

See also

Common printing tasks

Accessing the printer driver

Finishing tab



Selecting paper by source

If your application supports printing by paper source, make the selections from your application. Application settings override 
printer driver settings.

You can configure the printer to select paper by Source (such as Tray 1 or Tray 2).

To select paper by source

1 Access the printer driver.

2 From the Paper tab, select the desired source of paper.

3 Click OK.

The printer is now set to print your document from the source you selected.

_________________________________________________

See also

Common printing tasks

Accessing the printer driver

Paper tab



Using EconoMode

EconoMode (Save Toner) allows the printer to use less toner on each page. Selecting this option will extend the life of your 
toner cartridge and reduce your costs per page, but will reduce print quality.

Click here        to see which printer driver is set as your default.

To enable or disable EconoMode

1 Access the printer driver.

2 From the Finishing tab, click EconoMode (Save Toner).

If the box is checked, EconoMode is enabled. If the box is empty, EconoMode is disabled.

3 Click OK.

The printer is now set to use the EconoMode setting you have selected.

_________________________________________________

See also

Common printing tasks

Accessing the printer driver

Finishing tab



Using REt

REt (Resolution Enhancement technology): On refines the print quality of characters by smoothing out jagged edges that can 
occur on the angles and curves of a printed image. Choose Off if graphics, particularly scanned images, are not printing clearly.

Click here        to see which printer driver is set as your default.

To enable or disable REt

1 Access the printer driver.

2 From the Finishing tab, click Details.

3 In the Print Quality Details screen, select the desired REt option (On or Off).

4 Click OK.

_________________________________________________

See also

Common printing tasks

Accessing the printer driver

Finishing tab




